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Preface

This Administration Guide provides critical information about the processing and 
operating details of Product, including the following:

■ System configuration settings

■ Technical architecture

■ Functional integration dataflow across the enterprise

■ Batch processing

Audience
This guide is for:

■ Systems administration and operations personnel

■ Systems analysts 

■ Integrators and implementers

■ Business analysts who need information about Product processes and interfaces

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired.

Related Documents
For more information, see the following documents in the Oracle Retail Home Release 
19.1 documentation set:

■ Oracle Retail Home User Guide

■ Oracle Retail Home Security Guide
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Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

■ Product version and program/module name

■ Functional and technical description of the problem (include business impact)

■ Detailed step-by-step instructions to re-create

■ Exact error message received

■ Screen shots of each step you take

Review Patch Documentation
When you install the application for the first time, you install either a base release (for 
example, 3.0) or a later patch release (for example, 3.0.1). If you are installing the base 
release and additional patch releases, read the documentation for all releases that have 
occurred since the base release before you begin installation. Documentation for patch 
releases can contain critical information related to the base release, as well as 
information about code changes since the base release.

Improved Process for Oracle Retail Documentation Corrections
To more quickly address critical corrections to Oracle Retail documentation content, 
Oracle Retail documentation may be republished whenever a critical correction is 
needed. For critical corrections, the republication of an Oracle Retail document may at 
times not be attached to a numbered software release; instead, the Oracle Retail 
document will simply be replaced on the Oracle Technology Network Web site, or, in 
the case of Data Models, to the applicable My Oracle Support Documentation 
container where they reside.

This process will prevent delays in making critical corrections available to customers. 
For the customer, it means that before you begin installation, you must verify that you 
have the most recent version of the Oracle Retail documentation set. Oracle Retail 
documentation is available on the Oracle Technology Network at the following URL:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.ht
ml

An updated version of the applicable Oracle Retail document is indicated by Oracle 
part number, as well as print date (month and year). An updated version uses the 
same part number, with a higher-numbered suffix. For example, part number 
E123456-02 is an updated version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all 
previous versions.

Oracle Retail Documentation on the Oracle Help Center 
(docs.oracle.com)

Oracle Retail product documentation is also available on the following Web site:

https://docs.oracle.com/en/industries/retail/index.html

https://docs.oracle.com/en/industries/retail/index.html
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(Data Model documents can be obtained through My Oracle Support.)

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Global Area Configuration

The Global Area Configuration page allows an admin user to configure certain 
components of the branding area including the application name, the color of the 
activity indicator and the logo.

Figure 1–1 Global Area Configuration

The Global Area Configuration page can be reached through the Settings menu 
(Settings ' User Interface ' Global Area Configuration).

After making changes on this page click the 'Save' or 'Save and Close' button to apply 
the new settings.

To revert to the default settings simply remove the custom value and save.

Note: Logos can be any standard web image type including SVG, 
PNG, etc. and will be scaled to a maximum height of 18 px and a 
maximum width of 140 px. Logo files are limited to 2 MB in size.
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2Application Navigator Setup

The Retail Home Application Navigator Setup page gives administrators the ability to 
configure applications within Retail Home. Retail Home uses these applications to 
populate its application navigator menu, to define dashboard tiles within Retail Home 
dashboards and to populate the application navigator menus in other Retail 
Applications.

Figure 2–1 Retail Home Application Navigator Setup Page

Figure 2–2 Retail Home Application Navigator



System Generated Application Navigator Entries

2-2 Oracle Retail Home Administration Guide

Figure 2–3 Retail Home Dashboard

System Generated Application Navigator Entries
Retail Home creates an initial set of application entries for known Retail Applications 
upon initial installation or upgrade to current version. These entries only contain the 
name and application code for applications and are initially disabled. On upgrade, the 
oldest entry for each known application will be flagged instead of inserting a new 
application (when present).

Launching the Application Navigator Setup Page
The Application Navigator Setup page can be launched from the Retail Home Settings 
menu's Application Administration section.

Figure 2–4 Application Navigator Setup Link in Retail Home's Settings Menu
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The Application Navigator Setup page shows a table of all the application navigator 
entries currently configured in Retail Home.

Figure 2–5 Retail Home Application Navigator Setup Page

The following information is shown for each application:

■ Features - Displays whether these features are enabled or not for this application: 
Application Navigator, Notifications, Favorites, and Resource Bundle 
Customizations.

■ Application Name - The name that will be displayed in Application Navigator 
menus and in Retail Home Dashboard Tiles.

■ Color Set - The color scheme used to display this application in the Retail Home 
Application Navigator menu and in Retail Home Dashboard Tiles.

■ Application Code - The unique code associated with a Retail Application. This is 
required to support features such as Favorites, Notifications and Resource Bundle 
Customization.

■ Application Link - The URL used to launch the application from Application 
Navigator menus or from the header of a dashboard tile. 

■ Platform Service URL - The URL used to access Platform ReST Services. This is 
required to support features such as Favorites, Notifications and Resource Bundle 
Customization.

■ Seeded - Shows whether the application was seeded by Retail Home

The table toolbar gives users the ability to add, duplicate, edit, delete, refresh and 
reorder applications, as well as manage roles associated with each application.

Adding an Application Navigator Entry
The Add icon  on the table toolbar allows users to add a new Application Navigator 
entry in Retail Home.

To add an application navigator entry, users enter the following information in the 
"Add Application Info" dialog:

■ Seeded - Shows whether the application is a seeded application or not.

■ Application Navigator Switch - Controls whether the application will be 
displayed in the Retail Home Application Navigator menu.
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■ Application Name - A unique name for the application that will be displayed in 
the Application Navigator menus and in the Retail Home Dashboard Tile header.

■ Color Set - The color scheme used to display this application in the Retail Home 
Application Navigator menu and for the background of the Retail Home 
Dashboard Tile.

■ Application Code - The unique code associated with a Retail Application. This is 
required to support features such as Favorites, Notifications and Resource Bundle 
Customization.

■ Application Link - The URL used to launch the application from Application 
Navigator menus or from the header of a dashboard tile.

■ Platform Service Switch - Controls the display of options under platform services 
(URL & sup-ported features).

■ Platform Service URL - The URL used to access Platform ReST Services. This is 
required to support features such as Favorites, Notifications and Resource Bundle 
Customization.

■ Platform Service Supported Features - Check boxes to determine whether 
Notifications, Favorites & Resource Bundle Customization is available for the 
application.

Figure 2–6 Add Application Info Dialog

Saving the New Application Navigator Entry
The OK and OK and Create Another buttons in the "Add Application Info" dialog 
will save all entered values in the dialog into Retail Home.

Duplicating an Application Navigator Entry
The "Duplicate" icon  on the table toolbar allows users to create a new application 
navigator entry using the selected application navigator entry as a starting point.

Users can modify the details in the “Add Application Info” dialog.   See the section 
above titled Adding an Application Navigator Entry for details about adding a new 
application navigator entry.
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Editing an Application Navigator Entry
The Edit icon  on the table toolbar allows users to change the details of an existing 
application navigator entry in Retail Home.

Users can modify the details in the "Edit Application Info" dialog:

Figure 2–7 Edit Application Info Dialog

Deleting an Application Navigator Entry
The "Delete" icon  on the table toolbar allows users to delete the selected application 
navigator entry from Retail Home.

Reordering Application Navigator Entries
The order of the application navigator entries in the Manage Application Navigator 
table is the order that the applications will be displayed in the Application Navigator 
menus in Retail Home and in other Retail Applications.

The “Move Up” icon  and the “Move Down” icon  on the table toolbar allow users 
to move the selected application navigator entry up or down in the table.

Managing Roles
Roles can be associated with each application navigator entry to restrict which users 
will have access to the application through the application navigator menus outside of 
Retail Home. Users who do not have access to the application will not see it in the 
application navigator menus.

Note: It is allowed to duplicate from an existing seeded entry, but the 
new application navigator entry will not be considered a seeded entry.

Note: Users cannot delete seeded entries from the Manage 
Application Navigator page.
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Enabling Roles
Roles are disabled by default and all users will see links to all applications in the 
application navigator menus. Use the Enable Roles button in the table toolbar to 
enable role mappings.

Mapping Roles to Applications
Mapping roles to applications is accomplished through the upload of a CSV formatted 
file containing a mapping of applications to roles. The CSV file is required to have 
columns “App Name” and “Role Name”. Any other columns included in the file will 
be ignored. The “App Name” column should contain the name of the application 
currently shown in the Application Name column. The keyword “all” may be used in 
the “App Name” column in place of an application name to map a role to all 
applications currently in the table. The “Role Name” column should contain a valid 
enterprise role name.

Importing a Role Mapping
Import the role mapping CSV file using the Import Role Mapping button on the table 
toolbar. A successful import will replace the role mappings for all applications 
currently managed in Retail Home.

Seeding Data From Applications
Applications can provide a standard configuration for Retail Home dashboards 
through platform services. When imported, Retail Home will automatically create any 
specified dashboards or additional application entries specified in the data.

There are two ways to tell Retail Home to load this data. When a new application is 
created or a seeded entry updated with platform services enabled, Retail Home will 
automatically attempt to load seed data. Additionally, the data for an application can 
be manually updated by pressing the refresh seed data button in the toolbar.

If an application does not provide seed data or has not deployed a supported version 
of the platform services, no update will occur and the failure will be logged silently. In 
the case of a manual refresh, an error will be displayed to the user.

For full details on the behavior of importing seed data, refer to Chapter 9, "Seeding 
Application Dashboards".

Publishing Application Navigator Entries
Application navigator entries can be published to the applications that are associated 
with a domain. These applications are represented by the system-generated 
application navigator entries. Data that is published includes the details of each 
application including links and role mappings. Only applications that have an 
application link will be published. Use the Publish button located in the page footer to 
publish this data.

Once the application navigator entries have been published, if further changes are 
made to the application navigator entries or the role mappings it will be necessary to 
publish again in order for those changes to be pushed out to the domain applications.
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Customer Modules Management
The Retail Home Customer Modules Management page gives customer administrators 
the ability to activate or deactivate provisioned applications and modules.

Figure 2–8 Retail Home Customer Modules Management Page

Applications and modules that are deactivated will not be accessible to users.    
Scheduled batch processes may also be halted when those processes are tied to 
deactivated applications and modules.

The management of customer modules in Retail Home requires domains to be 
configured first since information about customer-provisioned applications and 
modules reside in the domains' Module Definition Framework (MDF) data.

Launching the Customer Modules Management Page
The Customer Modules Management page can be launched from the Retail Home 
Settings menu's Application Administration section.

Important Note: If the application navigator entries for an 
application are currently managed through ORAAC (Oracle Retail 
Application Admin Console) then this Publish action will replace the 
application navigator entries that were configured through ORAAC.
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Figure 2–9 Customer Modules Management Link within Retail Home's Settings Menu

The Customer Modules Page displays the customer-provisioned modules in a 
hierarchical table structure.

Only modules provisioned to the customer are displayed.
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Figure 2–10 Retail Home Customer Modules Management Page

The columns include:

■ Module Code - A unique identifier for an application or module.

■ Module Name - The descriptive name of the application or module.

■ Type - The type of module which can be one of the following:

– Application - A Retail Application

– Module - A feature within the Retail Application or another module.

– Group - A grouping of applications or modules.

■ Offer - The offer code used to provision the application to the customer.

■ Active - A flag indicating if the application or module is active or not.

Activating and Deactivating Customer Modules
Customer administrators can activate or deactivate customer-provisioned applications 
or modules by interacting with the toggles for each row's Active column.

Figure 2–11 Customer Modules Management Page's Toggle components for Active 
Statuses

Only "Application" or "Module" typed rows can be toggled.

Toggling the active state of an application or module also toggles the state of child 
modules.



Dashboard Configuration

2-10 Oracle Retail Home Administration Guide

When a parent application or module is deactivated, its child modules will be 
deactivated and their toggle components will be disabled. Activating the parent, 
activates the child modules and enables their toggles.

Saving or Discarding Customer Module Changes
Changes to the activation states are not persistent until the user clicks on the page's 
Save button.

Figure 2–12 Customer Modules Management page's Cancel and Save Buttons

Once the changes are saved:

■ Deactivated applications and modules will cause applications and features to be 
inaccessible to users. Scheduled batch processes may also be halted when those 
processes are tied to deactivated applications and modules.

■ The association of applications to domains is recalculated.

The page's "Cancel" button discards all changes made to the applications and modules.

Resetting Activation Status to Default
The "Reset to Defaults" button reverts the activation status of all provisioned 
applications and modules to default.

Figure 2–13 Customer Modules Management Page's "Reset to Defaults" Button

Reset values are not saved until the user clicks on the page's Save button.

Dashboard Configuration
Retail Home is a portal-type application for the RGBU enterprise. The UI consists of a 
tile-based configurable dashboard that highlights important metrics and KPIs across 
RGBU applications. A Retail Home administrator configures persona-based 
dashboards for each enterprise role through the Dashboard Configuration flow.



Tile Configuration

Application Navigator Setup 2-11

The Retail Home dashboard can be configured with 4 different kinds of reports.

■ Tile state reports render within dashboard tiles. A tile can display up to 5 tile state 
reports.

■ Expanded tile reports can be launched from a tile state to show more data.

■ Banner reports render in the region above the tiles.

■ Contextual area reports render on the right side of the screen next to the tiles and 
below the banner.

A Retail Home administrator can access the Dashboard Configuration flow as follows:

1. Open the Settings menu.

2. Open the Dashboard and Reports submenu.

3. Open the Dashboards submenu.

4. Select Dashboard Configuration. This will open the Dashboard Configuration 
flow in a tab.

Tile Configuration
In Retail Home, an administrative user defines dashboards for enterprise roles. Users 
will see the dashboards configured for their enterprise role(s) when they log in to 
Retail Home. This section describes how to create dashboard tiles, the first step in the 
Dashboard Configuration flow.

Adding a Tile
To add a new dashboard tile, complete the following steps:

1. In the Dashboard Configuration flow, select the Tiles tab if it is not already 
selected.
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Figure 2–14 Creating Dashboard Tiles

2. Click on the Add icon to open the Create Tile Dialog Box.

Figure 2–15 Create Tile

3. Enter text in the Tile Name text box.

4. Select the appropriate Application from the drop down. The URL, URL 
Extension, and Tile Color fields will be populated with corresponding values. The 
URL field gets the application URL automatically, but the user has the ability to 
override the value using the Override URL switch.
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Figure 2–16 URL Extension & Override URL Switch

5. The URL field is editable if Override URL is enabled. Clicking OK when the URL 
field is editable saves the value entered in the text area. Clicking OK when the 
URL field is disabled will override the value with the application URL.

6. Enter URL Extension. The URL Extension is appended to the URL when the OK 
button is clicked.

7. Select the appropriate Tile Color in the drop down.

8. Click OK to save your changes and close the dialog box. Click OK and Add 
Another to save your changes. Click Cancel to close the dialog box without saving 
your changes.

Editing a Tile
1. In the Tile tab, select a row containing tile information. This will make the Edit 

icon clickable.

2. Click the Edit icon to open the Edit Tile Dialog Box. Make edits in the dialog box 
as shown in Figure 2–17. Click OK to save the edits. Click Cancel to not save the 
edits.

Figure 2–17 Edit Tile

Deleting a Tile
To delete a tile, select the appropriate row in the table, click the Delete icon in the table 
toolbar, and click OK in the confirmation dialog. Click Cancel to cancel the delete.
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Figure 2–18 Delete Tile

Filter Configuration
Retail Home supports the creation of filters for dashboard tiles. Filter options can be 
configured on a per-application basis and can be retrieved from a REST endpoint or BI 
analysis. Filter options can also be manually defined in the UI.

Adding a Filter
To add a new filter for an application, complete the following steps:

1. In the Dashboard Configuration flow, select the Filters tab if it is not already 
selected.

2. Select the application to add a filter for from the list of applications on the left.

3. Select the add button  on the list of filters to the right.

4. Toggle the Active switch to turn on the filter.
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5. Enter a Display Name and the Parameter the filter applies to. The parameter is the 
actual string sent to the tile state's data source.

6. Select the Type of filter to add. The supported filter types are radio buttons, 
toggles, multi-select inputs, checkboxes, and numeric inputs.

7. Define the filter options for the filter. They can be set to load from a data source 
(either BI or REST service) or be manually entered.

Filters must be enabled on a tile before they will appear in the UI. See the later section 
on configuring tiles for details.

Editing or Removing a Filter
An existing filter can be edited by selecting it and selecting the edit button  to open 
the dialog again. Filters can be removed by selecting the remove button  and 
confirming.

Configuring Filter Options
Filter options can be manually input or configured to load from a BI or REST data 
source.

Manual Configuration
To manually enter filter options, select Enter Manually in the dialog.

The first column is the label to display to the user and the second column is the string 
that will be submitted to the tile state's data source. Additional rows can be added 
with the button at the bottom. The controls on the left and right offer options for 
rearranging the list and removing rows.

To localize the display names, open the edit dialog in a browser using a different 
locale. Any changes to the display name column will only apply for the locale you are 
currently in.
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Data Sources
Selecting the data source option presents a second choice of which type of data source 
to use. Service endpoint allows calling a REST service, BI allows returning results from 
a BI analysis.

A service endpoint must be implemented according to the instructions in the 
developer's guide. Enter the full URL to the service in the field. The endpoint will be 
called with the nameSearch and pageSize query parameters and return JSON 
containing filter options.

A BI analysis can also return filter options. Enter the catalog path to the corresponding 
analysis in the BI instance Retail Home is integrated with. The BI analysis should 
accept a NameSearch parameter and return two columns for the value and display 
name respectively.

Data sources are expected to provide their own localization.

Layout Configuration
In Retail Home, an administrative user defines dashboards for enterprise roles. Users 
will see the dashboards configured for their enterprise role(s) when they log in to 
Retail Home. This section describes how to associate enterprise roles with application 
tiles.

Adding a Role
To add a new dashboard for a role, complete the following steps:

1. In the Dashboard Configuration flow, select the Layouts tab if it is not already 
selected.
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Figure 2–19 Mapping Table for Role and Application Tiles

2. Click the Add icon. The Add Role dialog box is displayed. The dialog displays a 
Role Name search listing out the roles that are configured.

Figure 2–20 Add Role

3. Enter text in the Role Name text box to search for a specific role. If the result 
includes more than one role, select the appropriate one.

4. Click OK to save your changes and close the dialog box. Click OK and Add 
Another to save your changes and to add additional roles. Click Cancel to close 
the dialog box without saving your changes.

Duplicating a Role Configuration
To duplicate an existing association between a role and an application, complete the 
following steps:

1. In the Dashboard Configuration flow, select the Layouts tab if it is not already 
selected.
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Figure 2–21 Mapping Table for Role and Application Tiles

2. Select the row in the table that you wish to duplicate to another role.

3. Click the Duplicate icon. The Duplicate Role Configuration dialog box is 
displayed.

Figure 2–22 Duplicate Role Configuration

4. Enter text in the To Role text box to search for a specific role. If the result includes 
more than one role, select the appropriate one.

5. Click OK to save your changes and close the dialog box. Click OK and Duplicate 
Another to save your changes and duplicate the configuration to another role. 
Click Cancel to close the dialog box without saving your changes.

Adding/Editing Tile Layout to a Role
You can add a tile, change the order of the tiles, toggle the display, and adjust the size 
of a tile.

To add a tile to a role, complete the following steps.

1. From the Dashboard Configuration flow, select the Layouts tab if it is not already 
selected.
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Figure 2–23 Mapping Table for Role and Application Tiles

2. Select the Role in the table that you wish to edit. The tiles associated with the role 
is displayed in the layout table to the right.

3. Click on the add icon for the tile to be associated with the role from the available 
Tiles listed out on the left column of the layout table. The selected tile is added to 
the right column of the layout table. The Roles table is also updated with the 
selected tile.

4. To change the order of application tiles, select a tile and click on the Up/Down 
Arrow icon. The Roles table is updated accordingly.

5. To adjust the size of a tile, select an alternative size from the drop-down list. The 
Roles table is updated accordingly.

6. To import Tile Layout of another role to the selected role, click on the import 
layout button to open Import Layout Dialog box. Select the appropriate role from 
the drop down. Click OK to confirm the layout change. Click Cancel to close the 
Dialog box without saving the changes.

Figure 2–24 Import Layout Dialog Box

7. To Duplicate the Tile Layout of the selected role to another role, click on Duplicate 
Layout to Role button. Select the Role to which the layout needs to be applied. 
Click OK to confirm the layout change. Click Cancel to close the Dialog box 
without saving the changes.
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Figure 2–25 Duplicate Layout to Role Dialog Box

Deleting a Role
You can delete a role association record along with its associated tile, banner, and 
contextual configurations.

To delete a role, select that role, click the Delete icon in the table toolbar, then click OK 
to confirm the deletion.

Figure 2–26 Delete Role Confirmation

Tile States
Retail Home displays application tiles within the dashboard. You can configure 
application tile states and the data sources used for the metrics displayed in the tiles.

Figure 2–27 shows the Data configuration tab of the Dashboard configuration flow.

At the top of the screen, the Role and Retail Home Tile select controls are used to select 
which dashboard application tile to configure.

Tile States and Data Sources tables are rendered below the controls and are for 
configuring tile states and data sources respectively.

The following fields are configurable for Tile States:

■ Displayed - A check box that toggles between two states, displayed and not 
displayed.

■ Tile State Report - This field is mandatory and is used to indicate the report that is 
displayed in the tile state. 

■ Expanded Report - This field is optional and is used to indicate which expanded 
tile report can be launched from this tile state.

The following fields are configurable for Data Sources:

■ Data For - The report type that the data source is for, either Tile State or Expanded 
Report.

■ Active - A check box that toggles between two states, active and inactive. Only one 
data source for a report type can be active at a time.

■ Name - The name of the data source.

■ Type - The data type, either REST or FILE.
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■ Source - The URL for the source of the data.

Adding a Tile State
To add a tile state, complete the following steps:

1. In the Dashboard Configuration flow, select the Data tab if it is not already 
selected.

Figure 2–27 Tile Configuration for BUYER_JOB Role and Merchandising Application

2. Select a combination of role and Retail Home Tile from the drop-down list.

3. Click the Add icon in the Tile States table toolbar. The Add Tile State dialog box is 
displayed.

Figure 2–28 Add Tile State

4. Toggle the Displayed check box to control whether the tile state displays in the tile 
or not.

5. Select the desired Tile State Report from the drop-down list.

6. Optionally, select the desired Expanded Report from the drop-down list.

Note: Only five tile states can be displayed for a given 
role/application at a time.
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7. Click OK to save your changes and close the dialog box. Click OK and Add 
Another to save your changes and add another tile state. Click Cancel to close the 
dialog box without saving your changes.

Editing a Tile State
To edit a tile state, select the tile state in the table, click the Edit icon in the table 
toolbar, and make edits in the dialog, as shown in Figure 2–29, "Edit Tile State". Click 
OK to save the edits. Click Cancel to not save the edits.

Figure 2–29 Edit Tile State

Deleting a Tile State
To delete a tile state and its associated data sources, select the tile state in the table, 
click the Delete icon in the table toolbar, and click OK in the Confirmation dialog. 
Click Cancel to cancel the delete.

Figure 2–30 Delete Tile State

Moving a Tile State
To move a tile state within the list, select the tile state you want to move and use the 
Up Arrow and the Down Arrow icons to adjust the position as required.

Figure 2–31 Move Tile State

Note: The Favorites and Notification tile states are always the last 
two tile states respectively and cannot be moved.
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Adding a Data Source
To add a data source, complete the following steps:

1. In the Dashboard Configuration flow, select the Data tab if it is not already 
selected.

Figure 2–32 Adding Data Source

2. Select a combination of Role and Retail Home Tile from the drop-down menus.

3. Select the Tile State Report that you want to add a data source for.

4. In the Data Sources table toolbar, click the Add icon.

Figure 2–33 Add Data Source

5. Select the Data For value. If the data source provides data to a tile state report, 
select Tile State. If the data source provides data to an expanded tile report, select 
Expanded Report.

6. Select the Active check box to toggle to the active state.
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Figure 2–34 Change Active Data Source

7. Select the data source Name from the drop-down list.

8. Select the data source Type from the drop-down list.

9. Enter a valid URL for the data source.

10. Click OK to save your changes and close the dialog box. Click OK and Add 
Another to save your changes and add another data source. Click Cancel to close 
the dialog box without saving your changes.

Editing a Data Source
To edit a data source, select the data source in the table, click the Edit icon in the table, 
and edit the values in the Edit Data Source dialog, as shown in Figure 2–35, "Edit Data 
Source". Click OK to save the edits. Click Cancel to not save the edits.

Figure 2–35 Edit Data Source

Deleting a Data Source
To delete a data source, select the one you want to delete, click the Delete icon in the 
table toolbar, and click OK in the Confirmation dialog. Click Cancel to cancel the 
delete.

Note: If another data source is active, you will be asked if you want 
to make the new data source active upon saving. Click Yes to make 
the new data source active.

Note: The URL will be validated and you will receive an error 
message if the URL is not valid.
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Figure 2–36 Delete Data Source Confirmation

Duplicating a Tile Configuration
You can duplicate all of the tile states and their associated data sources from the 
selected role/application intersection to another role.

Click the Duplicate button at the bottom of the page. Then, use the Duplicate to Role 
search to find and select the Role to which you wish to duplicate the configuration.

Click OK to duplicate the tile configuration. Click OK and Duplicate Another to 
duplicate more than one tile configuration. Click Cancel to not duplicate the 
configuration.

Figure 2–37 Duplicate Tile Configuration

Selecting Filters for a Tile
Filters for an application must be applied to individual tile states before they will show 
up for a user.

This table allows enabling a filter for a tile state as well as designating whether it is 
required or not.

Filter values will be passed as query parameters to the data source backing a tile state.

Banner and Contextual Area Configuration
You can configure Retail Home to display reports and metrics in the banner and 
contextual areas of the Dashboard.

Note: Currently there are no report layouts for banner and 
contextual reports available in the release version of Retail Home.
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Figure 2–38 Banner and Contextual Area

To configure the reports and metrics, complete the following steps:

1. In the Dashboard Configuration flow, select the Banner and Contextual Area tab if 
it is not already selected.

2. Select a role from the Role drop-down list.

3. Select the Banner Active check box. This determines whether or not the banner is 
displayed on the dashboard. If the banner is active, you must provide a value for 
the following:

■ Select a layout from the Layout drop-down list.

■ Select a banner data source name from the Banner data Name drop-down list.

■ Select a data source type from the Type drop-down list.

■ Enter a valid data source URL into the Source text box. The URL will be 
validated.

4. To configure the Contextual Area, select the check box to make the Primary Area 
active or the Secondary Area active. If you make both areas active, then both will 
be displayed on the dashboard. If you do not want to display the Contextual Area, 
then do not make either area active.

For whichever area(s) you have designated (Primary and/or Secondary) as active, 
provide values for the following:

■ Select a layout from the Layout drop-down list

■ Select a data source name for the report from the Name drop-down list.

■ Select a data source type from the Type drop-down list.

■ Enter a valid data source URL into the Source text box. The URL will be 
validated.

5. Click Save to save your work and continue. Click Save and Close to save your 
work and close the tab.

Duplicating a Banner and Contextual Area Configuration
You can duplicate your Banner and Contextual Area Configuration to another role's 
Dashboard.
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Once the configuration has been saved for the currently selected Role, click the 
Duplicate button at the bottom of the page.

Select the role you want to duplicate the configuration to in the Duplicate to Role 
field.

Click OK to save your changes and exit the dialog box. Click OK and Duplicate 
Another to repeat the process with another role. Click Cancel to not duplicate the 
configuration.

Figure 2–39 Duplicate Banner and Contextual Area Configuration

Application Dashboard
The Retail Home Application Dashboard page gives customer administrators the 
ability to view information about the products to which they have subscribed.

Figure 2–40 Retail Home Application Dashboard Page

Launching the Application Dashboard Page
The Application Dashboard page can be launched from the Retail Home Settings 
Menu's Application Administration section.
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Figure 2–41 Application Dashboard Page Link within Retail Home's Settings Menu

Subscription Metrics
The subscription metrics displays details related to all the applications subscribed by 
the customer which includes the ability to view usage history, view installed version 
and turn off alerts for nearing the overextension of a subscription. The default value 
for alerts is set to "on". The customer would also see a "Currently Overextended" 
message for applications whose current usage cross the permitted purchased limit.

Figure 2–42 Application Dashboard Subscription Metrics

The customer administrator can access list of multiple versions (if present) by clicking 
on the "Multiple" link assigned to the "Version installed" property.

Version History Contextual Pane
Version history contextual pane shows details related to previously installed versions, 
installed date and release notes related to each version. The pane can be accessed by 
clicking the "View Version History" link. If the application does not support version 
reporting, a "No version information available" message will be displayed.
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Figure 2–43 Application Dashboard Version History Contextual Pane

Setting Alerts Status
Customer Administrators have the ability to turn on and off alerts for nearing the 
overextension of a subscription. The default value is set to 'on' position.

Figure 2–44 Application Dashboard Setting Alerts Status



Application Dashboard

2-30 Oracle Retail Home Administration Guide



3

Report Configuration 3-1

3Report Configuration

This chapter describes the reports that are included with Retail Home along with 
requirements for their configuration.

Tile State Reports
These reports are available to use on tile states within an application tile. See 
Dashboard Configuration for details about configuring tile states and data sources.

Favorites
The Favorites tile state report can be included on an application's tile if that 
application supports favorites. The Favorites report will display the items (tasks, 
reports, etc.) that have been marked as "favorite" by the user within the target 
application. The user can click on a favorite item to launch the favorite item in the 
target application within a separate browser window.

Sample

Note: Currently there are no report layouts for banner and 
contextual reports available in the release version of Retail Home

Table 3–1 Data Source Configuration

Name favoritesService

Type REST

Source https://{host}:{port}/RetailAppsReSTServices
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Notifications
The Notifications tile state report can be included on an application's tile if that 
application supports notifications. The Notifications report will display the unread 
notifications for the current user. The user can click on a notification to launch that 
notification in the target application within a separate browser window.

Sample

Two Metric Summary
The Two Metric Summary report displays one or two metrics in a standard layout. The 
data is retrieved from a service endpoint that conforms to the standard API supported 
by this report. Currently this report can be used to integrate with Apex. Refer to the 
Apex Integration section for more details.

Sample

Table 3–2 Data Source Configuration

Name notificationsService

Type REST

Source https://{host}:{port}/RetailAppsReSTServices

Table 3–3 Data Source Configuration

Name RetailHomeReportDataService
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Tile State Report Templates
Refer to the Custom Tile State Report Configuration section for details about the 
available Tile State Report Templates as well as data source configuration 
requirements for custom reports based on those templates.

Type REST

Source https://{host}:{port}/path/to/service/endpoint

Table 3–3 (Cont.) Data Source Configuration
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4Custom Tile State Reports Configuration

Retail Home not only ships with built-in reports, but also supports the creation of 
custom tile state reports from within the application.

This chapter describes the process for creating custom tile state reports from a tile state 
report template.

To access the Custom Tile State Reports page, complete the following steps:

1. Open the Settings navigation menu.

2. Select Dashboards and Reports.

3. Select Dashboards.

Figure 4–1 Configuration

4. Select Custom Tile State Reports, shown in Figure 3-27 Custom Tile State Reports, 
which displays a table listing all the custom tile state reports that have been added 
and a toolbar that is used to add, edit, and delete custom tile state reports.
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Figure 4–2 Custom Tile State Reports

Adding a Custom Tile State Report
To add a custom tile state report, complete the following steps:

1. Click Add in the table toolbar to open the Add Custom Tile State Report dialog.

Figure 4–3 Add Custom Tile State Report

2. Select a template from the Report Template drop-down list. Note that the Report 
Parameters section of the dialog will update dynamically, depending on the 
selected template since each template defines its own set of report parameters.

3. Enter a name in the Report Name field. This name is used to identify the report in 
the Tile Configuration step of the Dashboard Configuration page.

4. Complete the Report Parameters section. See the documentation for each Report 
Template for an explanation of the template's Report Parameter fields and 
expected values.
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5. Click OK to add the custom tile state report or OK and Add Another to add the 
custom tile state report and then add another. Click Cancel to not create the 
custom tile state report.

Configuring the Image Link Template
The Image Link Template allows an administrator to create a tile state report that 
renders an image that launches a configured link in a new browser tab. For example, 
an administrator may create a "Company Website" tile state report that shows a 
company logo that when clicked opens the company's website in a new browser tab.

The following figure shows a tile state report that renders the Oracle logo and 
launches to the Oracle website.

The following screenshot shows the Image Link Template report parameters.

The Image Link Template has the following parameters:

Table 4–1 Image Link Template Parameters

Parameter Name Description

Link URL The URL that will be opened in a new browser tab when the 
image is clicked.

Link Label A label that will display when hovering over the image.

Image URL The URL where the image in the tile can be accessed.
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Configuring BI Two Metric Template
Tile state reports created from the BI Two Metric Template render the common Two 
Metric Template tile state layout with data coming from a Retail Insights (RI) analysis.

The following tile state uses the Two Metric Template tile state layout:

Figure 4–4 Tile State Example

Each metric has a label, value, and optional description. In the above tile state 
example, the first metric's label is Daily Sales Retail, its value is 5,837K, and its 
description is USD.

The BI Two Metric Template has the following report parameter configuration:

BI Analysis Catalog Path
The BI Analysis Catalog Location is the path to the analysis within RI.

Window ID A text identifier specifying which window / browser tab to open 
the link in. If you create multiple Image Link reports, but you 
want them all to open in the same browser window or tab, you 
would specify the same Window ID in each report. Otherwise, 
this can be any unique value.

Note: Retail Home must be installed with RI Integration enabled for 
this functionality to work properly.

Table 4–1 (Cont.) Image Link Template Parameters

Parameter Name Description
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The analysis path is a combination of the analysis's Location and Name, as found in 
the analysis's Properties within RI.

For example: /shared/Retail Home/Dashboard Tiles/Clearance Sales 
Retail Home Tile

Figure 4–5 Clearance Sales Retail Home Tile

In the above example, the analysis's Location is "

/shared/Retail Home/Dashboard Tiles" and the analysis's Name is "Clearance Sales 
Retail Home Tile." The full "BI Analysis Catalog Path" is formed by joining the 
Location and Name with a "/".

The structure of the RI analysis must match the documented format discussed in this 
section.

The analysis must have the following columns, in this specified order:

1. Metric 1 Label - Required label for the first metric. Displayed above the metric 
value.

2. Metric 1 Value - Required first metric value.

3. Metric 1 Format - Optional formatting code for the first metric. See discussion 
below for valid formatting values.

4. Metric 1 Desc - Optional description (e.g. currency code) to display below the first 
metric value.

5. Metric 2 Label - Required label for the second metric. Displayed above the metric 
value.

6. Metric 2 Value - Required second metric value.

7. Metric 2 Format - Optional formatting code for the second metric. See discussion 
below for valid formatting values.

8. Metric 2 Desc - Optional description (e.g. currency code) to display below the 
second metric value.

The structure of the following example analysis in RI is compatible with Retail Home's 
BI Two Metric Template.

Note: This template requires data for at least one metric and can 
display up to two metrics.
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Figure 4–6 Example Analysis in OBIEE

The following table lists the supported formatting codes that Retail Home uses to 
format numeric values.

No data source is required when adding tile state reports created with the BI Two 
Metric Template, since Retail Home can determine the data source from the 
information provided during installation; however, for more fine-grained control, 
configure a data source for each report created from the BI Two Metric Template. The 
reports use the RetailHomeBIService data source.

If the report backs a tile state that has filters set, the filters will be passed as variables 
to the BI analysis for processing.

Refresh Report on Filter Change
This parameter when checked indicates that the tile state report should refresh when 
the user updates the Retail Home dashboard filter. If not checked, the report will not 
reload. If checked, the report will reload. If the RI analysis supports being filtered by 
merchandise hierarchy, the report's data will be filtered by the user's merchandise 
hierarchy selection.

Configuring the Metric Summary Template
The metric summary templates are configured to render arbitrary metric summary 
tiles in Retail Home. There are templates for two, four, and six-metric tiles.

Table 4–2 Supported Formatting Codes

Code Description Format Example

N Number 1,234,567.89

S Short Number 1.2B, 3.1M, 9.95K

PC Percent 4.5%
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Administrators can configure the report to include or exclude specific headers when 
sending requests to the service. Additionally, this template supports sending a 
tileStateContext query parameter based on the RPAS templates, which consuming 
applications can use to send additional configuration data to the service.

Configuring the RPAS Metric Summary Template
The RPAS (Retail Predictive Application Server) Metric Summary Templates are 
pre-configured to render metrics sourced from the RPAS services as metric summary 
tiles in Retail Home. They are available for displaying two, four, or six-metric tiles.
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The template has the following features:

■ It allows RPAS services to be called with a configurable context value called the 
Tile State Context. This context value will be passed a query parameter 
(tileStateContext) to the RPAS services. The RPAS services can inspect this 
value to mutate business logic when calculating the metrics.

■ It is tailored for RPAS services standards for REST invocation. Specifically, RPAS 
Services will be called with the following characteristics:

– The REST request header "X-Requested-By" is always included with a value of 
"true".

– The REST request header "Accept-Version" is always excluded.

Administrators for Retail Home can use the "Add/Edit Custom Tile State Report" 
dialog to specify the Tile State Context value to be sent to the supporting RPAS service.

Administrators can also specify additional headers to be included and excluded in the 
REST service calls through the dialog.

Editing a Custom Tile State Report
To edit a custom tile state report, complete the following steps:

1. Select the tile state report that you want to edit in the table.

2. Click Edit. You see the Edit Custom Tile State Report dialog.
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Figure 4–7 Edit Custom Tile State Report

3. Make edits to the fields that you wish to change.

Deleting a Custom Tile State Report
To delete a custom tile state report, complete the following steps:

1. Select the tile state report that you want to delete in the table.

2. Click Delete in the table toolbar. You see a confirmation.

3. Click OK to delete the custom tile state report. Otherwise, click Cancel.

Adding a Custom Tile State Report to a Tile State
All custom tile state reports added on the Custom Tile State Reports page are available 
to add to a tile on the Tile configuration step of the Dashboard Configuration page. 
You can find each custom tile state report by looking for its Report Name that was 
entered on the Custom Tile State Reports page.

Note: You cannot change the Report Template of a custom tile state 
report once the report has been added. You must either add a new 
custom report tile state report or delete your existing custom tile state 
report and then add a new one.

Note: Each custom report is further marked as a custom report on 
the Tile Configuration screen with the word "(Custom)" appended to 
the custom report name.
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Figure 4–8 Custom Tile State Report
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5Oracle Application Express Integration

Retail Home is capable of accessing data through Oracle Application Express (APEX).

This integration works by creating a REST service in APEX that returns data to be 
rendered in a Retail Home report. A Retail Home administrator then must configure 
the report in Retail Home to pull its data from the APEX service. For more information 
on how to configure Dashboards within Retail Home, see Dashboard Configuration. 
For more information about how to create REST services through the APEX UI, please 
refer to the Oracle APEX documentation.

Only certain reports within Retail Home support APEX integration, and the APEX 
REST service must return data in the correct format expected by the report for the 
integration to work. This document discusses how to integrate APEX with Retail 
Home reports.

Two Metric Tile State Report
Retail Home provides a common two metric tile state report layout. It renders up to 
two metrics with metric names, metric values, metric labels, and optional indicators, 
such as arrows showing an increase or decrease in the metric value.

Service Query Structure
To integrate with this report, first create an APEX service. This service must be 
implemented as a SQL Query that returns 1 to 2 rows of data. A UNION can be used 
to return up to two rows.

The service must be configured to return the results as JSON, and the query must 
return the following columns:

Table 5–1 Columns Returned by Query

Column Name Required Description

NAME Yes The name of the metric value. This is 
displayed above the metric value.

VALUE Yes The metric value itself.

VALUE_FORMAT No An optional metric value formatting code. See 
the table of valid format values.

If no VALUE_FORMAT is returned, Retail 
Home will not format the metric value.

VALUE_LABEL No An optional label that further describes the 
metric value (e.g. a currency code). This label 
is displayed below the metric value.
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The following table lists the supported format values:

The following table lists the supported indicator values:

Service Query Examples
The following examples show different valid queries that can be used to return data 
that is in a compatible format with the Retail Home Two Metric tile state report. The 
examples select constant values from dual to demonstrate the concept; an actual 
service implementation's query would select real values from a table.

The following example query shows all the possible columns being returned:

select
  'Metric 1' NAME,
  1234567890 VALUE,
  'S' VALUE_FORMAT,
  'USD' VALUE_LABEL,
  'critical' INDICATOR
from dual

The following example query shows only the required columns being returned:

select
  'Metric 1' NAME,
  1234567890 VALUE
from dual

The following example query shows two rows being returned using a union:

select

INDICATOR No An optional indicator that is rendered before 
the metric value. See the table of valid 
indicator values.

Table 5–2 Format Values

Format Value Meaning Example

PC Percent Formats 0.045 as 4.5%

S Short Number Formats 9950000 as 9.95M

N Number Formats 1234567.89 as 
1,234,567.89

Table 5–3 Indicator Values

Indicator Value Meaning

up An upward pointing arrow

down A downward pointing arrow

normal A normal severity indicator.

info An info severity indicator

important An important severity indicator

critical A critical severity indicator

Table 5–1 (Cont.) Columns Returned by Query

Column Name Required Description
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  'Metric 1' NAME,
  1234567890 VALUE,
  'S' VALUE_FORMAT,
  'USD' VALUE_LABEL,
  'critical' INDICATOR
from dual
union
select
  'Order Count' NAME,
  8 VALUE,
  NULL VALUE_FORMAT,
  NULL VALUE_LABEL,
  NULL INDICATOR
from dual

Retail Home Tile State Report Configuration
This tile state report can be configured on the Tile Configuration train stop of the 
Dashboard Configuration screen.

First, create a new tile state:

1. Check the Displayed checkbox.

2. Select Two Metric Summary in the Tile State Report field.

3. Select an Expanded Report if an expanded report should be accessible through 
this tile state.

4. Click OK.

Then, add a data source for the tile state that will connect to your APEX service:

1. In the Data For field, select Tile State.

2. Check the Active checkbox.

3. In the Name field, select RetailHomeReportDataService.

4. In the Type field, select REST.

5. In Source, enter the complete URL to your APEX service.

6. Click OK.
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Supporting Retail Home Filters
Retail Home users can filter the data displayed in their dashboard by Merchandise 
Hierarchy, if this feature was enabled in the Retail Home installation. 

Retail Home passes these optional filter values as query parameters to the REST 
Service endpoint that is configured in APEX.

In the SQL query of an APEX REST Service endpoint, reference these filter values 
using following variables:

■ :departmentId

■ :classId

■ :subclassId

The following query example shows how different rows can be returned depending on 
what departmentId value is passed in the REST service query parameter:

select
  'Metric 1' NAME,
  1234567890 VALUE,
  'S' VALUE_FORMAT,
  'USD' VALUE_LABEL,
  'critical' INDICATOR
from dual
union
select
  'Order Count' NAME,
  8 VALUE,
  NULL VALUE_FORMAT,
  NULL VALUE_LABEL,
  NULL INDICATOR
from dual
where :departmentId IS NULL
union
select
  'Order Count' NAME,
  10 VALUE,
  NULL VALUE_FORMAT,
  NULL VALUE_LABEL,
  NULL INDICATOR
from dual
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where :departmentId = 1000

This idea can be extended to test for different values and to incorporate the classId and 
subclassId values as well.
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6Notifications Administration

RGBU Applications provide a feature-rich notifications framework, which sends a 
variety of different types of notifications to specific groups of users. Retail Home 
provides administrators with the ability to define types of notifications, set up groups 
of user roles that should receive each type, and configure how notifications of each 
type should be handled.

Manage Notifications
An administrator can access the Manage Notifications page through the Settings 
menu. To access the page, click Manage Notifications in the settings menu.

On this page, the user will see a section at the top to select the application which will 
be configured, and below that, a section titled Notification Types, and a section titled 
Notification Groups and Roles. Depending on the size of the user's browser window, 
the Notification Groups and Roles section may either appear to the side or below the 
Notification Types section.

When arriving at the Manage Notifications page, the administrator should first check 
the Application dropdown, to ensure that the desired application is selected. Only the 
selected application will be configured.
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Notification Types
The user can see the notification types on this page, under the heading Notification 
Types. In this area, the user will see a Filter bar, a toolbar with actions, and a list of 
notification types.

Notification Types Filter
The user can type in the filter bar to filter the list of notification types. The filter will 
display only the types that contain the filter text anywhere in the type name, type 
code, or description.

Notification Types Toolbar
The Notification Type Toolbar contains an Actions menu as well as four icon buttons: 
Create, Edit, Remove, and Refresh. These actions are described in further detail below.

Notification Types List
Each notification type in the list contains several pieces of information. First, in bold, is 
the name of the notification type.

Below that is the type code used by the system to identify the type, and a description 
of the type.

At the bottom, a Retention field indicates how long notifications of this type will be 
kept before they are deleted from the system. If the retention specifies permanent, then 
notifications of this type will never be deleted.

The last piece of information for a notification type is an email address, which will be 
sent an email notification whenever a notification of this type is generated. This field 
was designed to contain a mailing list email, but strictly speaking any email address 
may be provided.

The user can select one notification type from the list. Selecting a notification type will 
enable the edit and remove actions in the toolbar, as well as update the data in the 
Notification Groups and Roles section, discussed further below.

Creating and Editing Notification Types
To create a new notification type, the user must select the Create button on the toolbar 
or the Create item from the Actions menu. Similarly, to edit a notification type, the 
user must first select the type to be edited, and then select the Edit button on the 
toolbar or the Edit item from the Actions menu.
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When the user selects the Create or Edit action, a popup will appear prompting for the 
notification type details. If the user selected Edit, the fields of the popup will be 
prepopulated with the values of the selected notification type.

After entering the values for the fields, the user must click OK to finish creating or 
editing the type. At any time, the user may click Cancel to close the popup without 
creating or editing the notification type.

Removing a Notification Type
To remove a notification type, the user must first select the notification type to be 
removed. The user must then select the Remove button from the toolbar or the 
Remove item from the Actions menu. The user will then be presented with a 
confirmation popup. If the user clicks OK, the notification type will be removed. In 
addition, all existing notifications of this type will also be removed.

Refreshing Notification Types
At any time, the user may select Refresh from the toolbar or Actions menu. This will 
cause the page to refresh the list of Notification Types.

Notification Groups and Roles
Next to the Notification Types, the user can see the notification groups and roles that 
are associated with the selected notification type.
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In this area, the user will see a toolbar and a tree table listing the notification groups 
currently assigned to the selected notification type. The user can expand each 
notification group to view the roles that are part of the group. If no notification type is 
selected, this region will instruct the user to select a notification type.

Notification Groups and Roles Toolbar
The Notification Type Toolbar contains an Actions menu, and buttons for Create, Edit, 
Remove, Refresh, and Detach. These actions are described in further detail below.

Creating and Editing Notification Groups
To create a new notification group, the user must select the Create button on the 
toolbar or the Create item from the Actions menu. Similarly, to edit a notification 
group, the user must first select the group to be edited, and then select the Edit button 
on the toolbar or the Edit item from the Actions menu.

When the user selects the Create or Edit action, a popup will appear prompting for the 
notification group details. If the user selected Edit, the fields of the popup will be 
prepopulated with the values of the selected notification group.

Figure 6–1 Create Notification Group

On this popup, the user may add, edit, or remove roles from the notification group. To 
add the first role, simply type the name of the role into the Role field. To add more 
than one role, select the Add Role link below the Role field for each new role to be 
added. To edit a role, simply edit the text of the corresponding role field. To remove a 
role, click the Remove button for the corresponding role. Note that each role must 
correspond to a valid security role in the Identity Store. If a security role is not valid, 
the group will not be added or edited.

If the administrator edits a notification group, such as by adding or removing a role 
from the group, the changes will affect every notification type the group is assigned to, 
as well as all existing notifications of those types.

After entering the values for the fields, the user must click OK to finish adding or 
editing the group. At any time, the user may click Cancel to close the popup without 
creating or editing the notification group.

Removing Notification Groups
To remove a notification group from a notification type, the user must first select the 
notification group to be removed. The user must then select the Remove button from 
the toolbar or the Remove item from the Actions menu.
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The user will then be presented with a confirmation popup. If the user clicks OK, the 
notification group will be removed from the notification type.

Removing a notification group from a notification type will affect all existing 
notifications of the selected type. These notifications will no longer be visible to users 
from the removed group, unless they are part of a different group which still has 
access to the notification type.

The notification group may still be assigned to other notification types – only the 
currently selected type will be affected.

Refreshing Notification Groups
At any time, the user may select Refresh from the toolbar or Actions menu. This will 
cause the page to refresh the list of Notification Groups and Roles.

Detaching the Notification Groups Region
The user may detach the Notification Groups and Roles region from the page, causing 
it to appear as a popup. To do this, the user must select the Detach button from the 
toolbar or the Detach item from the View menu. To reattach the region to the page, the 
user must select the Detach button again, or select the Attach item from the View 
menu.
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7Role Requests

Retail Home users can use the Roles task in the Tasks menu to see their current role 
access, make requests for new roles, make requests to remove roles and view a history 
of previous requests.

Role Request Flow
When a user makes a request to add or remove a role a record is stored in the role 
request history for that user and a notification with the details of the request is 
generated in Retail Home. Admin users who have the role RH_ROLE_REQUEST_
ABSTRACT or RH_ROLE_REMOVE_ABSTRACT (depending on the request type) 
will receive the notification and can launch the IDCS Admin UI from the notification 
to handle the request.

Configuration

Incomplete Configuration
The configuration settings below must be completed before a user can make requests 
to add or remove roles. If any of these is not completed then the user will receive the 
following message when attempting to add or remove roles:  "Roles Hub configuration 
is not complete. Contact an Administrator to complete the setup process."
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IDCS Admin URL
Retail Home must be configured with a URL to launch the IDCS Admin UI during the 
installation of Retail Home (see the Retail Home Install Guide for details). When users 
make role requests a notification will be generated in Retail Home for the RH_ROLE_
REQUEST or RH_ROLE_REMOVE notification type depending on the type of request.  
An admin user who has received this notification can click on the notification to 
launch the IDCS Admin UI using the URL that was configured during installation.

Role Request Approver Email
When users make a request to add or remove a role a record is stored in the request 
history for that user. An approver email address is stored on the history record to 
indicate to the user who they can contact about the status of their request. No emails 
are generated by the system to this email address

The role request approver email can be configured from the Role Request 
Configuration page, which can be accessed through the Settings menu (Settings->Role 
Request Configuration).

Retail Home Application Navigator Setup
In order to create and display notifications for the Retail Home application a record 
representing the Retail Home application must be configured in the Application 
Navigator Setup page. This record must be configured with the "RH" application code 
and a valid Platform Service URL. Platform services are not deployed with Retail 
Home, so the Platform Service URL should point to the platform services deployment 
for one of the other installed retail applications that includes the platform services. See 
the Application Navigator Setup chapter for details on using the Application 
Navigator Setup page.
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All Oracle Retail applications come packaged with resource bundles, files that contain 
text resources. These text resources appear throughout the Oracle Retail application as 
instructions, messages, labels, errors, virtually any text that appears in the application 
comes from a resource bundle.

Many Oracle Retail applications support the ability for retailers to customize the text 
that appears in the Oracle Retail application to better match that retailer's business 
language. The capability to change the text for a resource is provided through the 
Resource Bundles area of Retail Home. Retailers can customize text resources for any 
Oracle Retail supported language.

Resources and Customizations Explained
All text resources in the Oracle Retail application have the following values:

■ Base Application Code - This value identifies the Oracle Retail application that 
owns this text resource.

■ Language - This value identifies the language of the text resource.

■ Bundle - This value identifies the bundle file where this text resource resides.

■ Resource - This value is the unique name that can be used to get the text for this 
resource.

■ Base Text - This value is the text provided by the Oracle Retail application. This is 
the text that will appear in the application by default.

Every text resource in Oracle Retail applications is uniquely identified by the 
combination of Application Code, Language, Bundle, and Resource.

A resource customization is a change that a retailer made to the text of a resource. In 
addition to the values above, customizations also have the following values.

■ Custom Text - This is the custom text provided by the retailer for the resource.

■ Current Text (or Text) - This is the text that will actually appear in the Oracle 
Retail application. If a retailer has provided custom text for the resource, then this 
value will display the retailer's custom text. Otherwise, it will display the base text 
provided by the Oracle Retail application.

Tasks
The Resource Bundles area of Retail Home consists of the following tasks.

■ Resource Text Strings
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■ Imports Management

Resource Text Strings
From the Retail Home Settings menu, a Retail Home admin user can access the 
Resource Text Strings link under the Resource Bundles submenu. The Resource Text 
Strings screen provides the capability to customize the resources present in the 
resource bundles of an application. The user can search the resources in an application 
using the Application, Bundle, Language, Resource, Text and Contains Custom Text 
fields.

Figure 8–1 Resource Text Strings Screen

The results table in the Resource Text Strings screen will display the Resource, Base 
Text, Current Text, Updated Date, and Updated By columns for the resources matching 
the entered search criteria. If there is a custom value present for a resource, it will be 
displayed in the Current Text column along with the date and the user who 
customized that entry. If there is no custom value present for a resource, the Current 
Text column will display the base text and the Updated Date and Updated By columns 
will be displayed empty. The user can edit or remove custom text for a resource using 
this screen.

The user can also export the results table to an Excel CSV file, which can be modified 
and later imported through the Imports Management screen. The export and import 
actions allow the user to provide custom text for many resources at one time, and 
upload all the custom values in a single action in Retail Home.

Figure 8–2 Edit or Remove Custom Text
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Add or Edit
The user can add or edit the custom text for a resource using the Edit menu item or the 
pencil icon. If no custom text is present for a resource, a new custom text will be 
added. If a custom text is already present for a resource, it will be modified. The 
Updated Date and Updated By columns will be changed to reflect the addition or 
modification. The Edit option opens up a popup showing the resource, its base text 
and editable custom text. Only one record can be edited at a time in a popup.

Figure 8–3 Edit Resource Text

Remove Customization
The user can remove the custom text for one selected resource using the Delete menu 
item or the cross icon. The user can select a single record and remove the custom value 
for the record. The base text is not impacted by the Delete operation. Upon completion 
of the delete operation a snack bar notification is shown to the user. The user can either 
undo the delete action or dismiss the notification.

Figure 8–4 Delete Custom Text Snack Bar Notification

Export to CSV
The user can export the details of the resources from the results table to an Excel CSV 
file. When the user selects the Export to CSV action, the browser will perform its 
download behavior. Depending on the user's browser preferences, the browser may 
prompt the user asking whether the exported file should be opened or saved, what 
program should be used to open the file, or where on the user's computer the file 
should be saved.

Importing Customizations from a CSV File
The user can change the values in the Text column of an exported CSV, and then 
import the CSV file through the Imports Management screen. See the section below 
titled Imports Management for more details about the Imports Management screen. 
When the user does this, the values of the Text column are imported into the custom 
text of each newly customized resource. The user can customize multiple rows with a 
single action by importing a file that contains multiple customized rows. Importing a 
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file that has not been modified will do nothing, since the text for each resource is 
already exactly the same in the Oracle Retail application.

The imported file must meet the following requirements for the import to succeed:

■ The imported file must be a well-formed CSV file. The user can use any 
compatible program to edit the exported CSV file, as long as the program is able to 
read the CSV file and save it again in CSV format.

■ The user should only edit values in the Text column. If the user edits any of the 
values in the Base Application Code, Language, Bundle, or Resource columns, the 
import may fail, or invalid customizations may be created.

■ The user can only add or edit customizations in the import. The user cannot 
remove customizations using import. Deleting the contents of the Text field or 
copying the Source Text into the Text field will cause the row to be ignored.

■ The size of the imported file is limited to 2000 KB. Users will not be allowed to 
upload a file larger than this. 

When the user selects the Import CSV file action, a popup opens prompting the user to 
select a file to import.

Figure 8–5 Import CSV File Dialog

It is possible that, after a user exports resources to a CSV file, but before the user 
imports the file through Retail Home, another user may customize one or more of the 
exported resources. In this case, the values of resources in Retail Home would be 
newer than the values in the exported file. In order to ensure that an import does not 
inadvertently overwrite these values, the import action will skip resources that have 
been recently updated in Retail Home, and notify the user. The user can tell the import 
to instead use the values from the imported file by selecting the "Overwrite recently 
updated resources" checkbox on the import popup.

Imports Management
From the Retail Home Settings menu, a Retail Home admin user can access the 
Imports Management link under the Resource Bundles submenu. The Imports 
Management screen provides the ability to create, view and manage import actions, 
and to take action to resolve any issues encountered during an import.
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Figure 8–6 Imports Management Screen

The Imports table will display information about each import that has been created for 
the currently selected application. The table will display the Status, Errors, File Name, 
Created By, Created Date, Last Updated By, and Last Updated Date. The user can 
create a new import, delete an import, mark an import as complete, restart an import, 
or view the errors for an import from this screen.

Figure 8–7 Imports Management Actions

Create
The user can import a CSV file from the Imports Management screen. See the section 
above titled Importing Customizations from a CSV File for more details.

Delete
The user can delete one or more imports. When the user deletes an import, that row is 
removed from the table completely, as well as any unresolved errors in the import. 
Any customizations that were already created by the import will still exist. The user 
cannot delete an import that is in "Pending" status. This is to make sure that an import 
is not deleted while it is being processed.

Note that there is no purge process for imports. All imports will remain in the 
database until manually deleted by the user.
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Mark as Complete
The user can select an import that is in "Complete with Errors" status and change the 
status to "Complete" This indicates that the user has finished addressing errors with 
the import, and all outstanding errors should be dismissed.

Restart Import
After the user addresses any errors that were encountered when importing 
customizations, the user can restart the import to create customizations for the fixed 
resources.

View
When an import on the Imports Management screen is marked with status "Complete 
with Errors," this means that the import encountered errors with one or more of the 
customizations in the imported file. In the table, the Errors column indicates the 
number of customizations that had errors. This number becomes a link that the user 
can click to view details for the customizations with errors. This takes the user to a 
modal page within Imports Management. See the section below titled View Errors for 
more details.

View Errors
The Import Errors screen allows the user to view the details of any errors encountered 
while importing customizations from a CSV file. The user can reach this screen via the 
Imports Management screen. See the View subsection within the Imports Management 
section above for more details.

Figure 8–8 View Errors Page

The Import Errors screen allows the user to view all imported customizations that 
encountered errors, as well the error message indicating why that customization could 
not be created. The Errors table displays Line Number, Base Application Code, 
Language, Bundle, Resource, Text, and Error Message. The user can edit or delete an 
imported customization, or Export to CSV.
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Edit
The user can edit the selected imported customization in the Edit Error dialog. The 
Edit Error dialog supports edits to the Base Application Code, Language, Bundle, 
Resource, and Text columns. This allows the user to resolve cases where a 
customization does not identify an existing resource, or cases where two or more 
customizations identify the same resource.

Figure 8–9 Edit Error Dialog

Delete
The user can delete an imported customization. The imported record is removed from 
the errors table, and no customization is created.

Export to CSV
The user can export the contents of the Errors table back to a CSV file, fix any errors in 
the CSV, and re-import the file. In this case, the user would generally want to return to 
the Imports Management screen and mark the first import as complete, since the 
errors were fixed by creating a new import.

Important Considerations While Customizing Resources
When customizing resources:

■ When customizing a resource text, consider the length of the custom text 
compared to the base text. Some of the labels and messages may not look good on 
the page if the custom text is too long compared to the base text.

■ After customizing the resource text, the changes may not be immediately visible in 
the application if the application uses a resource bundle cache. If the application is 
using a resource bundle cache, the customized resources are visible in the 
application only after the resource bundle cache expires. Please refer to the 
application documentation for the cache expiry time.
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9Seeding Application Dashboards

Retail Home provides three methods to seed configurations for applications. The first, 
discussed in Chapter 2, "Application Navigator Setup", is to press the seed data button 
on the application navigator configuration screen. Additionally, data may be loaded in 
bulk by using the standalone Retail Home Seed Utility or by making direct calls to the 
seed service.

The Retail Home Seed Utility
The Retail Home Seed Utility is a standalone Java utility that populates the application 
list and dashboards of a Retail Home deployment. It takes a wallet containing admin 
credentials for Retail Home, a JSON template of application URL patterns, and a CSV 
of applications to load and populate. The JSON and a template of the CSV file are 
provided in an accompanying ZIP file.

Wallet Credentials
The wallet for the seed utility is a standard Oracle Wallet containing the credential 
map oracle.retail.apps.platform.services.common.model.security 
with two keys:

■ idcsOAuthClient - IDCS application client ID and secret

■ idcsOAuthUser - Retail Home administrator username and password

Application CSV
The CSV file containing application information has two columns. The first column is 
the application code of the Retail application, which must correspond to an entry in 
the template JSON. The second column is the application host (the domain and port) 
of the external URL for the application.

Template JSON
There should be no need to modify the provided template JSON, which maps 
application codes to the format for the full application URL and the platform service 
URL (the application host value is substituted in for <app.host>).

Calling the Seed Utility
The seed utility is invoked as follows:

java -jar RetailHomeSeedUtil.jar <Retail Home Host> <IDCS URL> <Wallet> 
<Application File> <Template File>
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The Retail Home host is the protocol, domain, and port of the URL to Retail Home. 
The IDCS URL is the same to the IDCS tenant. The remaining fields are the paths 
(relative or absolute) to the files needed to run the utility.

When running, the utility may report that it was unable to retrieve seed data for one or 
more applications. This is normal behavior and means that the installed version of the 
application in question does not provide seed data.

Calling the Seed Service
In most cases it should be sufficient to let the application navigator page or seed utility 
call the seed service to upload seed data. However, in some cases, such as migrating 
configurations, a direct call may be more convenient. The seed service exposes a single 
endpoint/seed that can be called with either GET or PUT methods.

Calling the endpoint with GET will return the entire configuration of the Retail Home 
instance. Calling the endpoint with PUT allows uploading the configuration in the 
same format. 

Seeding Behavior
The general behavior of the seed utility is to merge configurations where possible. 
Most aspects of the configuration can be merged into existing settings. Some items 
cannot be matched to corresponding entries in the existing configuration however; in 
these cases the entire set of items will be replaced with the incoming configuration.

The following configurations will be replaced when loading seed data:

■ Application role mappings

■ Dashboard tile states for existing tiles

■ Application filters

All other configurations will be merged with incoming data.

Seed Data Format
The format for the seed data JSON is as follows:

Root

Applications
Application entries represent applications registered with Retail Home.

Property (*=required) Type Description

applications Array Array of Application objects to be configured

tiles Array Array of Tile objects to be configured

dashboards Array Array of Dashboard objects to be configured

properties Array Array of Property objects to be configured

reports Array Array of Report objects to be configured

filters Array Array of Filter objects to be configured
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Tiles
Tiles define available tiles to be displayed on dashboards.

Dashboards
Dashboard objects define the unique dashboard associated with a given role in Retail 
Home.

Property (*=required) Type Description

*name String Name of the application to display in Retail Home. 
Must be unique.

applicationCode String Unique identifier for Retail applications. Required for 
applications in a domain

*colorSetId String Color set to use for the application in Retail Home. See 
below for supported values

*active Boolean Whether the application is active. Inactive applications 
are not displayed in Retail Home.

applicationLink String The base URL to the application

platformService String The base platform REST service endpoint for the 
application.

Warning: Domains populate this value based on the 
domainUrl. Setting this will override the default value.

roles Array Array of Role objects the application is available to. 
Each role object has a single property containing the 
role name: validRole. When roles are enabled in 
Retail Home, this application will not be visible to 
other roles in application navigators after a publish.

Property (*=required) Type Description

*tileName String The name of the tile to display in Retail Home. Must be 
unique.

*tileColor String The color to use for the tile. See below for supported 
colors.

url String The URL to launch when the tile header is clicked. 
Supports the <app.url> token when associated with an 
application, which indicates the tile will open relative 
to the application's applicationLink value.

applicationName String The name of the application this tile is associated with. 
Must be one of the applications defined in the seed 
data.

Property (*=required) Type Description

*jobRoleName String The job role the dashboard is for. Only one dashboard 
can be created per role.

*active Boolean Whether the dashboard is active. Inactive dashboards 
are not displayed in Retail Home.

defaultDashboard Boolean Whether the dashboard is the default. Default 
dashboards will be preferentially displayed when 
opening Retail Home.
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Dashboard Tiles
Dashboard tiles define an instance of a tile object shown on a given dashboard.

Tile States
Tile states are the individual data views on dashboard tiles. Each tile state refers to 
reports configured for the application and can show both a tile state and expanded 
report. Reports are drawn from those already configured for the Retail Home 
deployment.

Regions
Regions are the additional banner and contextual data view located above and beside 
the tiles in the dashboard. Reports are drawn from those already configured for the 
Retail Home deployment.

*tiles Array Array of Dashboard Tile objects on the dashboard. May 
be empty.

*regions Array Array of Region objects on the dashboard. May be 
empty.

Property (*=required) Type Description

tileSize String How much space to allocate to the tile. Supported 
values are "1x1" and "2x2".

*active Boolean Whether the tile is active. Inactive tiles will not be 
displayed in Retail Home

*tileName String The name of the tile being displayed. The name must 
be from the array of Tile objects in the seed data.

*tileStates Array Array of Tile States to display on the tile

Property (*=required) Type Description

*tileStateConfigId String ID of the tile state report to display

reportName String Name of custom report to display. Mutually 
exclusive with tileStateConfigId.

expandedReportConfigId String ID of the expanded report to display

*active Boolean Whether the tile state is active. Inactive tile states 
will not be displayed in Retail Home

*urlConfigurations Array Array of URL configurations configured as data 
sources for the tile state. No more than one active 
configuration per report type is allowed.

Property (*=required) Type Description

*active Boolean Whether the region is active. Inactive regions will not 
be displayed in Retail Home

*reportConfigId String ID of the report to display in this region

Property (*=required) Type Description
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URL Configurations
URL configurations register the data sources for regions and tile states.

Properties
Properties are used to turn on/off specific functionality on Retail Home. 

Reports
Reports are custom reports configured using templates in Retail Home.

*regionId String Which region this configures. Valid options are 
"Primary", "Secondary", and "Banner". No more than 
one configuration per region is allowed on a 
dashboard

*urlConfig UrlConfig The URL configuration set as the data source for the 
region

Property (*=required) Type Description

*contentType String Type of report this is configuring. Valid options are 
"region", "tilestate", "expanded", and "filter". Tilestate 
and expanded are only valid for tilestates. Region is 
only valid for regions. Filter is only valid for filters (see 
below)

*resourceId String ID of the service this URL configures.

*resourceType String What type of URL this is. Valid options are "REST", 
"FILE", and "LINK"

*url String The URL. FILE type URLs may use relative paths. 
REST and LINK URLs are strictly validated and must 
contain a protocol if they do not use replacement 
tokens (details below). Replacement tokens are only 
supported for tile states.

*active Boolean Whether this configuration is active. Inactive URL 
configurations are ignored by Retail Home.

Property (*=required) Type Description

*propertyKey String Key defining the Retail Home functionality. Currently 
"oracle.retail.apps.retailhome.
settings.appNavigator.enableRoles" is 
used to Enable/Disable Roles flag on 'Application 
Navigator Setup'.

*currentValue Boolean Whether this configuration is enabled.

Property (*=required) Type Description

*reportTemplateId String ID of the template for this report.

*reportName String Name of the report.

useLightBackground Boolean Whether to use a light background when displaying 
this report in a tile state. If false, the background will 
be drawn from the color set of the application.

Property (*=required) Type Description
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Report Parameters
Report parameters are used to configure the template of a custom report. The available 
and required parameters depend on the template being configured.

Filters
Filter objects define filters associated with applications.

Filter Translations
Translation objects provide localized strings for filters for a given application

*parameters Array Array of report parameters configuring this report. 
May be empty.

Property (*=required) Type Description

*paramPath String ID of the parameter in the template

*paramType String Type of parameter. Valid options are "text" and 
"boolean".

*textValue String Value of the parameter as a string.

Property (*=required) Type Description

*applicationName String The name of the application this filter is associated 
with. Must be one of the applications defined in the 
seed data.

*paramName String Name of parameter. This is appended to the REST call 
along with the value.

*filterName String Display name of the filter.

*filterType String Type of the Filter. Value options are 'MULTISLCT', 
'TOGGLECTRL', 'NUMINPUT', 'CHECKBOX' & 
'RADIOBTN'.

*active Boolean Determines whether this filter is active.

*urlConfig Object The URL configuration set for this filter.

options Array An array of filter options

translations Array An array of translations for the filter

Property (*=required) Type Description

*applicationName String Name of the application this translation is associated 
with. Must be one of the applications defined in the 
seed data.

*paramName String Parameter name this translation is associated with. The 
paramName must be defined in the filters block.

*filterName String Filter name this translation is associated with. The 
filterName must be defined in the filters 
block.

options Array An array of translated options

Property (*=required) Type Description
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Filter Options
Filter options store selectable options for filters that rely on a preset list rather than 
pulling options from elsewhere

*language String Language to which the translation needs to be applied.

*sourceLanguage String Original language of the base filter

Property (*=required) Type Description

*optionName String Name of the option to display in the UI

*optionValue String Value of the option to use when sending data

*displayOrder Number Order to display the option in the UI

*language String Language to which the translation needs to be applied. 
Not required for options on the parent Filter object.

*sourceLanguage String Original language of the base option. Not required for 
options on the parent Filter object.

Property (*=required) Type Description
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